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w do I create an unbound combo box?

n I implement the search capability using 
sual Basic?

torial exercises

sing a macro to run VBA code
ome things that cannot be done using the 
acro language. If the feature you wish to 

nt is critical to your application, then you 
lement it using VBA. However, since it is 
to call a VBA function from within a macro, 
ot have to abandon the macro language 
ly.

ction, you are going to execute the Param-

 subroutine you created in Section 12.3.6 
in a macro. Since the RunCode action of 
ss macro language can only be used to exe-
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Access Tutorial 15: Advanc

1 Introduction: Pulling it all 
together

is tutorial, you will bring together several of the 
s you have learned in previous tutorials to imple-
t some sophisticated triggers.

2 Learning objectives
How do I run VBA code using a macro?

How do I use the value in one field to 
automatically suggest a value for a different 
field?

How do I change the table or query a form is 
bound to once the form is already created?

What is the After Update event? How is it 
used?

How do I provide a search capability for my 
forms?
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Si
in

unction calls the 
ameterTest subroutine

eterTest intStart, intStop

eterTestWrapper = True   
rn a value

unction

he function, as shown in Figure 15.1.

te that the return value of the function is 
clared as an integer, but the actual assign-

ent statement is ParameterTestWrap-

r = True . This is because in Access/
A, the constants True  and False  are 
fined as integers (-1 and 0 respectively).

Using the RunCode action
 the module open (you may have to resize 
r move the debug window) and create a 
acro called mcrRunCodeTest .
. Advanced Triggers

te functions (not subroutines) you must do one of 
o things before you create the macro:

Convert ParameterTest  to a function — you do 
this simply by changing the Sub at the start of the 
procedure to Function .
Create a new function that executes Parame-

terTest  and call the function from the macro.

.3.1.1 Creating a wrapper

nce the second alternative is slightly more interest-
g, it is the one we will use.
• Open your basTesting  module from 

Tutorial 12.
• Create a new function called ParameterTest-

Wrapper  defined as follows:

Function 
ParameterTestWrapper(intStart As 
Integer, intStop As Integer) As 
Integer

'this f
Par

Param

Param
'retu

End F

• Call t

No
de
m
pe

VB
de

15.3.1.2
• Leave

and/o
new m
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arameterTest  subroutine.

Use the Print  statement to 
invoke the function (do not forget 
the parameters).

�

The return value of 
ParameterTestWrapper()  
is True, so this is printed when 
the function ends.
. Advanced Triggers

FIGURE 15.1: Create a function that calls the P

Create a function to call 
the ParameterTest  
subroutine.

�

Since ParameterTest  
does not return a value, its 
arguments are not in 
brackets.
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t Run > Start to execute the macro as 
n in Figure 15.3.

Using activity information to 
determine the number of credits
ction, you will create triggers attached to the 
ate event of bound controls.

Scenario

that each type of course activity is generally 
d with a specific number of credits, as 
low:

Activity  Credits

lecture 3.0

lab 3.0

tutorial 1.0

seminar 6.0
. Advanced Triggers

• Add the RunCode action and use the expression 
builder to select the correct function to execute, 
as shown in Figure 15.2.

The expression builder includes two parame-
ter place holders (<<intStart>>  and 
<<intStop>> ) in the function name. These 
are to remind you that you must pass two 
parameters to the ParameterTestWrap-

per()  function. If you leave the place holders 
where they are, the macro will fail because 
Access has not idea what <<intStart>>  
and <<intStop>>  refer to.

• Replace the parameter place holders with two 
numeric parameters (e.g. 3 and 6). Note that in 
general, the parameters could be field names or 
any other references to Access objects contain-
ing (in this case) integers.

• Selec
show

15.3.2

In this se
After Upd

15.3.2.1

Assume 
associate
shown be
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t the function to execute.

Note the <<intStart>>  and 
<<intStop>>  parameter place 
holders. These must be replaced 
with expressions that Access 
understands.
. Advanced Triggers

FIGURE 15.2: Use the expression builder to selec

Add a RunCode 
action to the macro.�

Use the expression builder to drill 
down to the user-defined functions in 
your database file.

�
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as well that the number of credits for a par-
e of course is not cast in stone. As such, 
ers given above are merely “default” val-

t to use the default credit values when you 
new course or modify an existing course. 
, the user may override this default if neces-
 particular course. The basic requirement is 
 in Figure 15.4.

Designing the trigger

 the foregoing, the answer to the “what” 
 is the following:

up the default number of credits associated 
he course activity showing in the form’s 
ty  field.
 this number into the Courses.Credits  
. Advanced Triggers

Assume 
ticular typ
the numb
ues. 

You wan
create a 
However
sary for a
illustrated

15.3.2.2

Based on
question

1. Look 
with t
Activi

2. Copy
field.

FIGURE 15.3: Execute the RunCode macro.

Replace the 
parameter place 
holders.

�

Select Run > Start (or press the ! icon in 
the tool bar) to execute the macro.�
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to a new record.

Select “Lecture” from the list of list of 
course activities created in Tutorial 8.

Create a macro to find the default number 
of credits and copy the value it into the 
Credits  field.

Once the Activity  field is updated, the 
macro executes. The value in the 
Credits  field can be changed by the 
user.
. Advanced Triggers

FIGURE 15.4: Inserting a default value in

Create a new record for a lecture-based 
course: COMM 437: Database Technology�

�

Since this is a new record, the default 
value of Credits  (like any numeric 
field) is zero. You want to use the 
information you just specified in the 
Activity  field to automatically 
look up the correct default number of 
credits for a lecture course and insert 
it in the Credits  field.

�

�
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15

re that you have a courses form (e.g., frm-

es ) and that the form has a combo box for 
ctivity  field. You may wish to order the 
 such that Activity  precedes Credits  in 
b order (as shown in Figure 15.4).

your move fields around, remember to 
just the tab order accordingly (recall 
ction 8.3.4).

Looking up the default value

iscovered in Section 14.3.5, Access has a 
()  function that allows you to go to the 

 table and find the value of Credits  
icular value of Activity . A different 
 is to join the Activities  table with the 
 table in a query so that the default value of 
 always available in the form. This is the 
 we will use here.
. Advanced Triggers

ere are several possible answers to the “when” 
estion (although some are better than others). For 
ample:

When the user enters the Credits  field (the On 
Enter event for Credits ) — The problem with 
this choice is that the user could modify the 
course’s activity without moving the focus to the 
Activity  field. In such a case, the trigger would 
not execute.
When the user changes the Activity  field (the 
After Update event for Activity ) — This choice 
guarantees that whenever the value of Activ-

ity  is changed, the default value will be copied 
into the Credits  field. As such, it is a better 
choice.

.3.2.3 Preliminary activities
• Modify the Activities  table to include a single-

precision numeric field called Credits . Add the 
values shown in the table in Section 15.3.2.1.

• Ensu
Cours

the A
fields
the ta

If 
ad
Se

15.3.2.4

As you d
DLookUp

Activities

for a part
approach
Courses

credits is
approach
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Si
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E 15.5: Use a join to make the default 
value available.
. Advanced Triggers

• Ensure you have a relationship (in the main rela-
tionship window) between Courses.Activity  
and Activities.Activity .

• Create a new query called qryCoursesAnd-

Credits  based on the Courses  and Activi-

ties  tables (see Figure 15.5). 

Notice that you have two credits fields: 
Courses.Credits  (the actual number of 
credits for the course) and Activi-

ties.Credits  (the “default” or “suggested” 
number of credits based on the value of 
Activity ). Access uses the <table 

name>.<field name>  notation whenever a 
query contains more than one field with the 
same name.

nce you already have forms based on the 
urses  table that expect a field called Credits  
ther than one called Courses.Credits ), it is a 

FIGUR
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 15.6: Rename one of the Credits  fields.

ename Credits  form the Activities  
able to DefaultCredits .
. Advanced Triggers

od idea to rename the Activities.Credits  
ld in the query. You do this by creating a calculated 
ld.

• Rename Activities.Credits  to Default-

Credits  as shown in Figure 15.6. Note that this 
eliminates the need for the <table 

name>.<field name>  notation.

.3.2.5 Changing the Record Source  of the 
form

ther than create a new form based on the qry-

ursesAndCredits  query, you can modify the 
cord Source property of the existing frmCourses  

rm so it is bound to the query rather than the 
urses  table.

• Bring up the property sheet for the frmCourses  
form and change the Record Source property to 
qryCoursesAndCredits  as shown in 
Figure 15.7.

FIGURE

R
t�
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ntage of using a join query in this manner is 
ultCredits  is now available for use 
 form and within any macros or VBA mod-

 run when the form is open.

Creating the SetValue  macro

alue  macro you require here is extremely 
ce you have DefaultCredits  available 
 scope of the form.

e the mcrCourses.SetCredits  macro 
own in Figure 15.8.

Attaching a procedure to the After 
Update  event

lick event of a button is fairly simple to 
nd: the event occurs when the button is 
he events associated with non-button 
perate in exactly the same way. For exam-
fter Update event for controls (text box, 

ox, check box, etc.) occurs when the value 
. Advanced Triggers

The adva
that Defa

within the
ules that

15.3.2.6

The SetV

simple on
within the

• Creat
as sh

15.3.2.7

The On C
understa
clicked. T
objects o
ple, the A
combo b

FIGURE 15.7: Change the Record Source  
property of an existing form.

Bring up the form’s property list and 
change its Record Source property.�

The field list now contains all 
the fields in the new query.
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of
Af
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on

h the mcrCourses.SetCredits  macro to 
fter Update event of the Activity  field.
 that the trigger works properly.

Use an unbound combo box to 
automate search
oned in Tutorial 8, a combo box has no 
earch capability. However, the idea of scan-
ort list of key values, selecting a value, and 
l the information associated with that record 
 the screen is so basic that in Access ver-

and above, this capability is included in the 
ox wizard. In this tutorial, we will look at a 
 different means of creating a combo boxes 
h from scratch. 

Manual search in Access

ow Access searches for records, do the fol-

 your frmDepartments  form.
. Advanced Triggers

 the control is changed by the user. As a result, the 
ter Update event is often used to trigger data verifi-
tion procedures and “auto-fill” procedures like the 
e you are creating here.

• Attac
the A

• Verify

15.3.3

As menti
intrinsic s
ning a sh
having al
pop on to
sion 7.0 
combo b
couple of
for searc

15.3.3.1

To see h
lowing:

• Open

FIGURE 15.8: Create the SetValue  macro.

Create a macro group called mcrCourses  
and a named macro called SetCredits .�

You can use the builder to set the arguments 
or simply type in the names of the fields.�
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e Enabled property of DeptCode  to No (the 
hould never be able to change the key val-

f existing records).

Creating the unbound combo box

thing to remember about the combo box 
pecify the search criterion is that it has 
o do with the other fields or the underlying 
 such, it should be unbound.
e an unbound combo box in the form 
r, as shown in Figure 15.10.

ge the Name property of the combo box to 
eptCode .
esulting combo box should resemble that 
n in Figure 15.11.

hen you create an unbound combo box, 
cess gives it a default name (e.g., 
mbo5). You should do is change this to 
mething more descriptive (e.g., cboDept-
. Advanced Triggers

• Move to the field on which you want to search 
(e.g., DeptCode );
Select Edit > Find (or press Control-F);

• Fill out the search dialog box as shown in 
Figure 15.9.

 the dialog box, you specify what to search for 
sually a key value) and specify how Access should 
nduct its search. When you press Find First, 
cess finds the first record that matches your 
arch value and makes it the current record (note 
at if you are searching on a key field, the first 
atching record is also the only matching record).

.3.3.2 Preliminaries

 make this more interesting, assume that the frm-

partments  form is for viewing editing existing 
partmental information (rather than adding new 
partments). To enforce this limitation, do the fol-

wing:
• Set the form’s Allow Additions property to No.

• Set th
user s
ues o

15.3.3.3

The key 
used to s
nothing t
table. As

• Creat
heade

• Chan
cboD

• The r
show

W
Ac
Co

so
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 “find” dialog box.
. Advanced Triggers

FIGURE 15.9: Search for a record using the

Move the cursor to 
the field you wish to 
search and invoke 
the search box 
using Control-F.

�

Enter the value you wish to find 
and set the other search 
parameters as required.

�

Press Find First to move to the first 
(or only) record that matches the 
search condition.

�

Limit the search to the current 
field (i.e., the field with the 
focus when the search box was 
opened).

�
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 combo box.
. Advanced Triggers

FIGURE 15.10: Create an unbound

Drag the separator for the detail 
down to make room in the form 
header

�

Create an unbound combo box by 
selecting the combo box tool and 
clicking in the header area.

�

Use the wizard in the usual way 
to get a list of valid DeptCode  
values and descriptions. The 
bound column for the combo box 
should be DeptCode .

�

Since the combo box is unbound, 
its value has to be stored for later 
use rather than stored in a field.

�
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Automating the search procedure 
using a macro

 implement search functionality with a 
ox, only two things are different from the 
earch in Figure 15.9: 

arch dialog box does not show up, and 
er selects the search value from the combo 
ther than typing it in.

c sequence of actions, however, remains 
. As a result, the answer to the “what” ques-
 following:

 the cursor to the DeptCode  field (this 
s the “Search Only Current Field” option to 
ed, thereby drastically cutting the search 

e the search feature using the current value 
DeptCode  as the search value.
. Advanced Triggers

Code). The advantage of the prefix cbo  is 
that it allows you to differentiate between the 
bound field DeptCode  and the unbound 
combo box.

15.3.3.4

When we
combo b
manual s

1. the se
2. the us

box ra

The basi
the same
tion is the

1. Move
allow
be us
time).

2. Invok
of cbo

FIGURE 15.11: An unbound combo box.

Although the DeptCode  column has been 
hidden, it is the “bound” column. As a result, 
the value of the combo box as it appears here 
is “COMM”, not “Commerce and ...”
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3.

Th
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•

RE 15.13: Fill in the arguments for the 
FindRecord  action.

Create a named macro called 
mcrSearch.FindDepartment .�

nter the action arguments. Do not forget the 
quals sign before the name of the combo box.

Since Value is 
the default 
property, its use 
is optional.
. Advanced Triggers

Move the cursor back to cboDeptCode  or some 
other field.

e only problem with this procedure is that the 
ptCode  text box is disabled. As a result, you must 

clude an extra step at the beginning of the macro 
 set its Enabled property to Yes and another at the 
d of the macro to return it to its original state.

• Create a new macro called mcrSearch.Find-

Department .
• Use the SetValue  action to set the Dept-

Code.Enabled  property to Yes. This can be 
done using the expression builder, as shown in 
Figure 15.12.

• Use the GotoControl  action to move the cursor 
to the DeptCode  text box. Note that this action 
will fail if the destination control is disabled.
Use the FindRecord  action to implement the 
search as shown in Figure 15.13.

FIGU

E
e�



Tutorial exercises15

NextHome Previous 18  o f  33

e of the property to set.
. Advanced Triggers

FIGURE 15.12: Use the builder to specify the nam

To set the Item argument, use the 
expression builder to drill down 
to the correct form.

�

 Select the unbound combo box 
(cboDeptCode ) from the middle 
pane. A list of properties for the 
selected object is displayed in the 
pane on the right.

�

The middle pane shows all the 
objects on the form including 
labels and buttons (hence the 
need for a good naming 
convention).
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sing Visual Basic code instead of 
a macro 
f attaching a macro to the After Update 
u can attach a VBA procedure. The VBA 
e is much shorter than its macro counter-

y (clone) of the recordset underlying the 
is created,
indFirst  method of this recordset is used 
 the record of interest.
ookmark” property of the clone is used to 
 to the corresponding bookmark for the 

 a VBA search procedure, do the following:
ge the After Update event of cboDeptCode  
ent Procedure”.
 the builder ( ) to create a VBA subrou-
. Advanced Triggers

Access interprets any text in the Find What 
argument as a literal string (i.e., quotation 
marks would not be required to find COMM). To 
use an expression (including the contents of a 
control) in the Find What argument, you must 
precede it with an equals sign (e.g., 
=[cboDeptCode] .

• You cannot disable a control if it has the focus. 
Therefore, include another GotoControl  action 
to move the cursor to cboDeptCode  before set-
ting DeptCode.Enabled = No .

• Attach the macro mcrSearch.FindDepart-

ment  to the After Update event of the cboDept-

Code combo box.
• Test the search feature.

15.3.4 U

Instead o
event, yo
procedur
part:

1. a cop
form 

2. the F
to find

3. the “b
move
form.

To create
• Chan

to “Ev
• Press

tine.
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Th
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•

•

-human-readable data type and therefore is 
 much use unless it is used in the manner 
n here. Setting the Bookmark property of a 
d makes the record with that bookmark the 
nt record. In the example above, the book-
of the records underlying the form is set to 
 the bookmark of the clone. Since the clone 
s bookmark set by the search procedure, 
 equivalent to searching the recordset 
lying the form. 

pplication to the assignment

Triggers to help the user
e a trigger on your order form that sets the 
l selling price of a product to its default 
 This allows the user to accept the default 
or enter a new price for that particular trans-
 (e.g., the item could be damaged). You will 
. Advanced Triggers

• Enter the two lines of code below, as shown in 
Figure 15.14.

Me.RecordsetClone.FindFirst 
“DeptCode = ‘” & cboDeptCode & “'”

Me.Bookmark = 
Me.RecordsetClone.Bookmark

is program consists of a number of interesting ele-
ents: 
• The property Me refers to the current form. You 

can use the form's actual name, but Me is much 
faster to type.
A form’s RecordsetClone  property provides a 
means of referencing a copy of the form's under-
lying recordset.
The FindFirst  method is straightforward. It 
acts, in this case, on the clone. 
Every recordset has a bookmark property that 
uniquely identifies each record. A bookmark is 
like a “record number”, except that it is stored as 

a non
not of
show
recor
curre
mark 
equal
had it
this is
under

15.4 A

15.4.1
• Creat

actua
price.
price 
action
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g a short VBA procedure.

ange the After Update event to 
ference an event procedure.

ess the builder button to invoke the VBA 
itor.

cess automatically names the 
broutine. Enter the two lines of code.
. Advanced Triggers

FIGURE 15.14: Implement the search feature usin

Ch
re�

Pr
ed�

Ac
su�
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•

15
O
is 
pr

0.4). The problem is updating the Back-

table itself because two different situations 
e considered: 

ord for the particular customer-product 
ination exists in the BackOrders  table  -- 
ckorder record exists for a particular cus-
 and a particular product, the quantity field 
 record can be added-to or subtracted-from 
ckorders are created and filled.
tomer-product record does not exist in 
ackOrders  table  -- If the particular cus-
 has never had a backorder for the product 
stion, then there is no record in the Back-

s  table to update. If you attempt to update 
existent record, you will get an error.

equired, therefore, is a means of determin-
er a record already exists for a particular 

r-product combination. If a record does 
n it has to be updated; if a record does not 
. Advanced Triggers

have to think carefully about which event to 
attach this macro to.

• Create a trigger on your order form that calcu-
lates a suggested quantity to ship and copies this 
value into the quantity to ship field. The sug-
gested value must take into account the amount 
ordered by the customer, any outstanding backo-
rders for that item by that customer, and the cur-
rent quantity on hand (you cannot ship what you 
do not have). The user should be able to override 
this suggested value. (Hint: use the MinValue()  
function you created in Section 12.5.)
Provide you customer and products forms with 
search capability.

.4.2 Updating the BackOrders  table
nce a sales order is entered into the order form, it 
a simple matter to calculate the amount of each 
oduct that should be backordered (you did this in 

Section 1
Orders  
have to b

1. A rec
comb
If a ba
tomer
of the
as ba

2. A cus
the B
tomer
in que
Order

a non

What is r
ing wheth
custome
exist, the
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ex
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15

If 
Ite

Se
du
at

ee Section 15.3.2.4 to review renaming 
lds in queries).

t if the backordered quantity is positive, 
 backordered. If the backordered quantity is 
, backorders are being filled. If the backor-
antity is zero, no change is required and 
ords should no be included in the results of 
. 

Import the shortcut function

e Visual Basic for Applications (VBA) mod-
ining the code for the 
ackOrders()  function. This module is 
d in an Access database called 
.mdb  that you can download from the 

ome page.
_V2.mdb is for those running Access ver-
.0. To import the module, select File > 
. Advanced Triggers

ist, then one has to be created. This is simple 
ough to talk about, but more difficult to implement 

 VBA. As a result, you are being provided with a 
ortcut function called UpdateBackOrders() 

at implements this logic.

e requirements for using the UpdateBackO-

ers()  function are outlined in the following sec-
ns:

.4.2.1 Create the pqryItemsToBackOrder  
query

you have not already done so, create the pqry-

msToBackOrder  query described in 
ction 10.4. The UpdateBackOrders()  proce-
re sets the parameter for the query and then cre-

es a recordset based on the results.

If you did not use the field names OrderID , 
and ProductID  in your tables, you must use 
the calculated field syntax to rename them 

(s
fie

Note tha
items are
negative
dered qu
these rec
the query

15.4.2.2

Import th
ule conta
UpdateB

containe
BOSC_Vx
course h

• BOSC

sion 2
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 Products . If any of your tables or fields 
d differently, an error occurs. To eliminate 

ors, you can do one of two of things: 

he VBA code. Use the search-and-replace 
e of the module editor to replace all 
ces of field names in the supplied proce-
 with your own field names. This is the rec-
nded approach, although you need an 
ate understanding of how the code works 

er to know which names to change. 
ge the field names in your tables (and all 
s and forms that reference these field 

s). This approach is not recommended. 

Understanding the 
UpdateBackOrders()  function
chart for the UpdateBackOrders()  func-
own in Figure 15.15. This function repeat-
 a subroutine, BackOrderItem , which 
. Advanced Triggers

Import, choose BOSC_V2.mdb, and select Mod-
ule as the object type to import.

• BOSC_V7.mdb is for those running Access ver-
sion 7.0 or higher. To import the module, select 
File > Get External Data > Import, choose 
BOSC_V7.mdb, and select Module as the object 
type to import.

.4.2.3 Use the function in your application

e general syntax of the function call is:
dateBackOrders(OrderID, CustomerID) .

e OrderID  and CustomerID  are arguments and 
ey both must be of the type Long Integer. If this 
nction is called properly, it will update all the backo-
ered items returned by the parameter query.

.4.2.4 Modifying the UpdateBackOrders()  
function

e UpdateBackOrders()  function looks for spe-
ic fields in three tables: BackOrders , Custom-

ers , and
are name
these err

1. Edit t
featur
instan
dures
omme
adequ
in ord

2. Chan
querie
name

15.4.3

The flow
tion is sh
edly calls
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up
rd

su

Th
m
Al
ita
na
qu
Ac
be

start

is
the list
empty?

error message

un pqryItemsToBackOrder
to get list of items to backorder

do until end of list

call BackOrderItems

stop

(CustID,ProductID,Qty)

yes

no

stop

FIGURE 15.15: Flowchart for 
UpdateBackOrders() .
. Advanced Triggers

dates or adds the individual items to the BackO-

ers  table. The flowchart for the BackOrderItem  
broutine is shown in Figure 15.16.

ere are easier and more efficient ways of imple-
enting routines to update the BackOrders  table. 
though some amount of VBA code is virtually inev-
ble, a great deal of programming can be elimi-
ted by using parameter queries and action 
eries. Since queries run faster than code in 
cess, the more code you replace with queries, the 
tter.

To get full marks for the backorders aspect of 
the assignment, you have to create a more 
elegant alternative to the shortcut supplied 
here.

r
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stop

check Products  table to
ensure valid ProductID

error message stopvalid?

add new record with
CustID , ProductID  & Qty

yes

yes

no

erItem  subroutine.
. Advanced Triggers

start

update Qty stop

search BackOrders  table for
matching CustID  & ProductID

found?

check Customer  table to
ensure valid CustID

error message stopvalid?

no

yes

no

FIGURE 15.16: Flowchart for the BackOrd
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15

In
sh
co
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15

Fu

Se

Di

db

Se

If 

“Back order cannot be processed: 
ontains no items”

rsBOItems.EOF

OrderItem(lngCustID, 
ms!ProductID, rsBOItems!Qty)

s.MoveNext

s.Close

ction

Explanation of the 
UpdateBackOrders()  function

 UpdateBackOrders(ByVal lngOr-

ng, ByVal lngCustID As Long)  — 
ement declares the function and its parame-
h item in the parameter list contains three 
: ByVal  or ByRef  (optional), the variable's 
d the variable's type (optional). The ByVal  
. Advanced Triggers

.4.4 Annotated source code for the 
backorders shortcut module.

 the following sections, the two procedures in the 
ortcut module are examined. In each case, the 
de for the procedure is presented followed by 
mments on specific lines of code.

.4.4.1 The UpdateBackOrders()  function

nction UpdateBackOrders(ByVal 
lngOrdID As Long, ByVal lngCustID As 
Long)

t dbCurr = CurrentDb

m rsBOItems As Recordset

Curr.QueryDefs!pqryItemsToBackOrder.
Parameters!pOrderID = lngOrdID

t rsBOItems = 
dbCurr.QueryDefs!pqryItemsToBackOrder
.OpenRecordset()

rsBOItems.RecordCount = 0 Then

MsgBox 
order c

Exit Sub

End If

Do Until 

Call Back
rsBOIte

rsBOItem

Loop

rsBOItem

End Fun

15.4.4.2

Function

dID As Lo

This stat
ters. Eac
elements
name, an
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Se

Items As Recordset  — In this decla-
tement, a pointer to a Recordset object is 
. This recordset contains a list of all the 
add to the BackOrders  table.

ueryDefs!pqryItemsToBackOrder

ters!pOrderID = lngOrdID  — This 
bit tricky: the current database (dbCurr ) 
a collection of objects called QueryDefs 
e what you create when you use the QBE 
signer). Within the collection of QueryDefs, 
ne called pqryItemsToBackOrder  
u created in Section 15.4.2.1).

ery QueryDef, there is a collection of zero 
arameters . In this case, there is one called 
 and this sets the value of the parameter 

lue of the variable lngOrderID  (which was 
o the function as a parameter).

Items = dbCurr.QueryDefs!pqry-

ackOrder.OpenRecordset()  — Here 
. Advanced Triggers

yword simply means that a copy of the variables 
lue is passed the subroutine, not the variable 
elf. As a result, variables passed by value cannot 
 changed by the sub-procedure. In contrast, if a 
riable is passed by reference (the default), its 
lue can be changed by the sub-procedure. 

t dbCurr = CurrentDb  — Declaring a vari-
le and setting it to be equal to something are dis-
ct activities. In this case, the variable dbCurr  
hich is declared in the declarations section) is set 
 point to a database object. Note that the database 
ject is not created, it already exists.

rrentDb  is a function supported in Access ver-
n 7.0 and higher that returns a reference to the 
rrent database. In Access version 2.0, this function 
es not exist and thus the current database must 
 found by starting at the top level object in the 
cess DAO hierarchy, as discussed in 
ction 14.3.1.

Dim rsBO

ration sta
declared
items to 

dbCurr.Q

.Parame

one is a 
contains 
(these ar
query de
there is o
(which yo

Within ev
or more P
pOrderID

to the va
passed t

Set rsBO

ItemsToB
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If 

on
Re
ze

“Back order cannot be processed: 

tains no items”  — The MsgBox 
t pops up a standard message box with an 
ton in the middle. 

 — If this line is reached, the list contains 
. As such, there is no need to go any further 
broutine.

— The syntax for If… Then… Else…  state-
quires an End If  statement at the end of 
itional code. That is, everything between the 
e End If  executes if the condition is true; 
, the whole block of code is ignored. 

rsBOItems.EOF  — The EOF property 
rdset is set to true when the “end of file” is 
red. 

OrderItem(lngCustID, rsBOI-

ductID, rsBOItems!Qty)  — A sub-
 used to increase the modularity and 
. Advanced Triggers

another set statement. In this one, the variable 
BOItems  is set to point at a recordset object. 
like the current database object above, however, 

is recordset does not yet exist and must be created 
 running the pqryItemsToBackOrder  parame-
r query.

penRecordset  is a method that is defined for 
jects of type TableDef or QueryDef that creates an 
age of the data in the table or query. Since the 
ery in question is a parameter query, and since the 
rameter query is set in the previous statement, the 
sulting recordset consists of a list of backordered 
ms with an order number equal to the value of 
rderID . 

rsBOItems.RecordCount = 0 Then  — The 
ly thing you need to know at this point about the 
cordCount property of a recordset is that it returns 
ro if the recordset is empty. 

MsgBox 

order con

statemen
Okay but

Exit Sub

no items
in this su

End If  
ments re
the cond
If  and th
otherwise

Do Until 

of a reco
encounte

Call Back

tems!Pro

routine is
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The BackOrderItem()  subroutine

kOrderItem(ByVal lngCustID As 
yVal strProdID As String, ByVal 
s Integer)

rr = CurrentDb

earch As String

ckOrders As Recordset

ckOrders = 
.OpenRecordset(“BackOrders”, 
nDynaset)

 = “CustID = “ & lngCustID & “ 
roductID = '" & strProdID & “'”

rders.FindFirst strSearch

Orders.NoMatch Then

stomers As Recordset

stomers = 
.OpenRecordset(“Customers”, 
nDynaset)

 = “CustID = “ & lngCustID

ers.FindFirst strSearch
. Advanced Triggers

adability of this function. Note the way in which the 
rrent values of ProductID  and Qty  from the 
BOItems  Recordset are accessed. 

BOItems.MoveNext  — MoveNext  is a method 
fined for recordset objects. If this is forgotten, the 
F condition will never be reached and an infinite 

op will be created. In VBA, the Escape key is usu-
ly sufficient to stop an infinite loop.

op  — All Do While /Do Until  loops must end 
th the Loop  statement.

BOItems.Close  — When you create a new 
ject (such as a Recordset using the Open-

cordset  method), you should close it before exit-
g the procedure. Note that you do not close 
Curr  because you did not open it.

d Function  — All functions/subroutines need 
 End Function /End Sub  statement.

15.4.4.3

Sub Bac
Long, B
intQty A

Set dbCu

Dim strS

Dim rsBa

Set rsBa
dbCurr
dbOpe

strSearch
AND P

rsBackO

If rsBack

Dim rsCu

Set rsCu
dbCurr
dbOpe

strSearch

rsCustom
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If 

M

Ex

En

Di

Se

st

rs

If 

M

Ex

En

rs

rs

rs

rders!Qty = intQty

rders.Update

rders.Edit

rders!Qty = rsBackOrders!Qty + 

rders.Update

Explanation of the BackOrderItem()  
subroutine

ny aspects of the language are covered in 
ous subroutine, only those that are unique 
broutine are explained. 

ckOrders = dbCurr.OpenRecord-

Orders”, dbOpenDynaset)  — The 
ordset  method used here is the one 

or a Database object. The most important 
t is the source of the records, which can be 
. Advanced Triggers

rsCustomers.NoMatch Then

sgBox “An invalid Customer ID number 
has been passed to BackOrderItem”

it Sub

d If

m rsProducts As Recordset

t rsProducts = 
dbCurr.OpenRecordset(“Products”, 
dbOpenDynaset)

rSearch = “ProductID = '" & strProdID 
& “'”

Products.FindFirst strSearch

rsProducts.NoMatch Then

sgBox “An invalid Product ID number 
has been passed to BackOrderItem”

it Sub

d If

BackOrders.AddNew

BackOrders!CustID = lngCustID

BackOrders!ProductID = strProdID

rsBackO

rsBackO

Else

rsBackO

rsBackO
intQty

rsBackO

End If

End Sub

15.4.4.4

Since ma
the previ
to this su

Set rsBa

set(“Back

OpenRec

defined f
argumen
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ingle quotes are used within the search 

rders.FindFirst strSearch  — 
 is a method defined for Recordset 

at finds the first record that meets the crite-
ied in the method's argument. Its argument 
t string stored in strSearch . 

Orders.NoMatch Then  — The 
 property should always be checked after 

g a record set. Since it is a Boolean variable 
alse) it can be used without an comparison 

rders.AddNew  — Before information can 
 to a table, a new blank record must be cre-
 AddNew method creates a new empty 
akes it the active record, and enables it for 
. Advanced Triggers

table name, a query name, or an SQL statement. 
e dbOpenDynaset  argument is a predefined con-

ant that tells Access to open the recordset as a 
naset. You don't need to know much about this 
cept that the format of these predefined constants 
different between Access version 2.0 and version 
0 and higher. In version 2.0, constants are of the 
rm: DB_OPEN_DYNASET. 

rSearch = “CustID = ”& lngCustID & “ 

D ProductID = ’” & strProdID & “'”  — 
string variable has been used to break the search 
ocess into two steps. First, the search string is 
nstructed; then the string is used as the parameter 
r the FindFirst  method. The only tricky part here 
that lngCustID  is a long integer and strProdID  
a string. The difference is that the value of str-

odID  has to be enclosed in quotation marks when 
e parameter is passed to the FindFirst method. To 

do this, s
string.

rsBackO

FindFirst

objects th
ria specif
is the tex

If rsBack

NoMatch

searchin
(True / F
operator.

rsBackO

be added
ated. The
record, m
editing.
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BackOrders!CustID = lngCustID  — Note 
e syntax for changing a variable’s value. In this 
se, the null value of the new empty record is 
placed with the value of a variable passed to the 
broutine. 

BackOrders.Update  — After any changes are 
ade to a record, the Update  method must be 
voked to “commit” the changes. The AddNew / 
it  and Update  methods are like bookends 

ound changes made to records. 

BackOrders.Edit  — The Edit  method allows 
e values in a record to be changed. Note that these 
anges are not saved to the underlying table until 
e Update  method is used.
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